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Intended Purpose

Indications for Use
Intended Use:

OrthoView is indicated for use when a suitable licensed and qualified healthcare
professional requires access to medical images with the intention of using such images
to plan or review a surgical procedure. OrthoView provides a set of tools and templates
(representing prosthetic and fixation devices) to assist the healthcare professional in
planning their surgery.

The device is not to be used for mammography.
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Description of the Device

OrthoView is software to be used for medical purposes, performing these purposes
without being part of a hardware medical device.

OrthoView is not an in vitro diagnostic device. OrthoView is a device that provides one or
more capabilities relating to the acceptance, transfer, display, storage, and digital
processing of medical images.

TABLE 1
Minimum Operating System Requirements
Computer PC or MAC compatible computer
Operating System MAC OS OS X 10.12 or higher
Operating System Windows Windows 7, 8, 8.1 or 10
Processor 1 GHz CPU
Memory 2GB RAM
Free Hard Disc Space 2GB free disk space
Graphics/Display 1280 x 1024 colour graphics display
(Optional) Intranet Connection to PACS 100MBit/Sec
(Optional) Internet Connection (required
for case management, auto template oMBit/Sec
update and anonymous stat collection
features only).

Requirements for Dicom Connectivity

e DICOM conformance to support C-ECHO, C-FIND, C-MOVE, C-STORE, Study
Level Retrieve, Series Level Retrieve, Image Level Retrieve

e Modality connection required on PACS to allow Query, Retrieve & Store images
(PACS supplier may charge for this)

Network: Minimum 10mb/sec network connectivity. (Gigabit recommended)
Peripherals: Keyboard & Mouse.

Internet Connectivity: For Software & Template download, tutorial videos and guides.
OrthoView Server: HTTP server or Network folder share (NFS) to use Web
Deployment, Concurrent licensing, FollowMe or ImageShare. (not all features are

compatible with all builds/versions)

DICOM Modality Connection: To import/export images with a PACS archive, modality
connection(s) may be required, for which your PACS supplier may charge.
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Introducing OrthoView ™

(English)

Important Notice: All diagrams and pictures shown are for illustrative purposes only and
readings or indications may not be the same as those obtained during actual use. Not all
options described are available in all versions of the software.

OrthoView provides the necessary tools for both Orthopaedic and Orthognathic surgery
planning.

OrthoView is fully configurable to suit individual surgeon requirements. A license must be
installed when starting the software. (Except for Demonstration versions where a license
is installed automatically)

Orthopaedic Planning Tool

OrthoView is a leading orthopaedic digital planning solution, used in hospitals and clinics
across the globe. The innovative software provides orthopaedic surgeons with access to
a comprehensive library of digital templates for joint replacement, trauma procedures,
limb deformity correction, spine deformity assessment and (subject to license) pediatric
assessment.

Developed in conjunction with the orthopaedic community and supplied by the major
PACS suppliers, OrthoView is a digital preoperative planning solution designed
specifically for orthopaedic surgeons and consists of several specialist modules, offering
a complete solution for orthopaedics.

The OrthoView templating process uses a technigue similar to the techniques that many
surgeons previously practiced with acetate templates over x-ray film. OrthoView can
assist with planning operative procedures by scaling, planning, reduction and templating
on one or more patient images and will generate reports that can accompany patient
notes.

OrthoView template wizards help you to quickly and easily get from an image of a
patient's x-ray to the approximate template size needed. The visual templating features
then let you quickly review multiple template sizes, against the x-ray, and obtain an
accurate view of the implant size required.

Orthognathic Planning Tool

NOTE: - This module is a separately licensable module not available in all
territories. Not available in the USA.

OrthoView also provides CMF surgeons with the necessary tools to plan orthognathic
surgeries using 2D images.

The different orthognathic planning tools allow the user to:

Import and scale x-rays

Perform a pre-operative analysis of the patient

Perform a digital cephalometric analysis

Plan virtual osteotomies and reposition bone segments to simulate treatment.
Display key measurements and allow the plan to be saved for later review.
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Installing a Temporary License

When you buy the software you will be issued with a temporary license that will activate
OrthoView enabling you to install and configure the software. You will also have been
supplied a unique product key which should be quoted in all correspondence; the code
will be similar to this: OR123-12345678.

The steps to installing a license are set out below:

(1) When OrthoView is run for the first time an alert message will prompt you to
enter details for the first user, click <OK> and you will be presented with a
registration screen to enter the user details. Once entered click <OK>
OrthoView will then display the License Agreement.

(2) Atter reading the License Agreement, click the <l Agree> to continue. The
software will report Valid License Not Found.

(3) Click the <Install License...> button and the License Manager screen will
appear.

(4) Select the <Install License...> button on this screen as well and it will open
a File Browser window which will enable you to navigate to the location of the
supplied license.

(5) Select the license by highlighting the license file name and clicking <Select>
OrthoView will then install a copy of this license in the Network Server
location you selected, in a folder named License.

Congratulations! Your license has been installed correctly.
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Major Work Flows

OrthoView has several major work flow stages:

Loading - Using the InBasket Panel (if available) to select the patient, and
selecting specific images and the procedure from the Examination Panel. (All
versions)

Scale - Scaling images to use within OrthoView in the Scaling Panel.

Analyze - Analyzing a procedure by measuring anatomical features using tools
and wizards in the Analyze Panel.

Reduce (Orthopaedic Only) - Performing reduction by manipulation of image
regions and/or fragments in the Reduce Panel.

Simulate (Orthognathic Only) — Simulate both skeletal and soft tissue
movements within the cranial, maxillary and mandible regions in the Simulate
Panel.

Template (Orthopaedic only) - Adding and adjusting suitable prosthesis
components in the Templating Panel.

Saving - Saving your work. This could be as work in progress that can be added
to later or committed as an unalterable examination.

Restart — Allows you to restart the current examination from the state it was
originally received by OrthoView.

Other panels which may be displayed to access other functionality include:

Query and Retrieve from PACS — (Not available in all builds) In some systems
images are sent directly from the PACS to the InBasket or Examination panel.
Otherwise images will need to be imported using this panel.

Template Management - The Template Management panel displays information
regarding installed and available digital templates. It is accessed from the File
menu drop-down or by pressing the <CTRL/CMD><T> key combination.

User Management — The User Management panel is used to create User
Accounts, Edit the Current User or Delete a User.

Preferences - The Preference Panels allow you to configure the software to suit
your personal Preferences and work practices. To begin setting Preferences
press <CTRL/CMD><R/,> or on the <File> menu, select <Preferences> to open
the Preferences panel.

Licensing — The Licensing panel is used to install a license, save the system
details for applying for a license and to review the License Agreement.

About - Displays information about your version of the software.
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SmartHelp

By default, OrthoView displays SmartHelp which is designed to assist you during your
use of the software and can be hidden or unlocked from the main display if required. It
will remember your last settings but is displayed as docked by default and the options
described below are available. This section describes all the possible display options
available from the SmartHelp toolbar.

The following are available from the SmartHelp toolbar when docked:

TABLE 2

F

Only available when SmartHelp displayed. Selecting this will hide the display.

# ™ | Only visible when SmartHelp is hidden. Selecting this will redisplay the
: SmartHelp.
P Undock the SmartHelp from main display. The undocked display can be moved

to any place on multiple displays by dragging the top bar of the display. The
undocked display can be re-sized by dragging the edges of the window.

iy

View previous displayed page.

&

View next page if available.

fi Increase the font size.

fo Decrease the font size.

<= |If enabled, the help displayed will follow your use of the software and show the
=" 'most appropriate help for the current activity. If disabled, the help for the current

activity can be displayed by pressing the <F1> key. (Pressing <F1> when
tracking is selected will not change the current display)
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If SmartHelp is undocked then the following are available from the toolbar:

TABLE 3

Docks the SmartHelp back to the right of the main display.

View previous displayed page.

View next page if available.

fi Increase the font size.

fo Decrease the font size.

<= | If enabled, the help displayed will follow your use of the software and show the
=" | most appropriate help for the current activity. If disabled, the help for the

current activity can be displayed by pressing the <F1> key. (Pressing <F1>
when tracking is selected will not change the current display)

Selecting this will force the SmartHelp to always be on top of other windows
displayed by the software. Deselecting this will return the window to normal
behavior.
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Moving around in OrthoView

You can move around OrthoView using your mouse and keyboard shortcuts. OrthoView
has a standard menu bar which allows access to a number of commands.

There are five basic methods of using a two button mouse within OrthoView:
(1) Move the cursor on the screen by moving the mouse.

(2) Clicking the left mouse button will select an object such as a tool or wizard.
Selecting a tool from the toolbar then clicking the left mouse button on the image will
place the tool. (Selecting a previously positioned tool or wizard will make that the
active one)

(3) Pressing the left mouse button and without releasing it, but moving the mouse, will
drag the selected object on the image. This is called left-dragging.

(4) Clicking the right mouse button over a selected object will display a menu selection
for that object if available.

(5) Pressing the right mouse button and without releasing it, but moving the mouse, will
allow various operations specific to that tool or wizard to be performed. This is
referred to as right-dragging.

Main display
Windows in OrthoView have the following features:

e Title bar. Displays the name of the program. (And OrthoView Menu Bar in OS X)
Note: When in Full Screen mode using OS X the Title bar is hidden but can be
displayed using the Spotlight Search shortcut of <CMD><space bar>

e Menu bar. Directly underneath the Title Bar. This displays the drop-down menus
available in OrthoView. Click a menu name to open the menu and see the
available commands.

e Generally available buttons. These are the generally available buttons you can
select when working in the main screens within OrthoView. When you are
scaling, analyzing, reducing or templating you can click Examination to return to
the Examination panel, which is useful if you want to open additional images. (If
you do this, you do not lose your work)

e Patient Information. Click the icon at bottom left hand side of screen to view
patient details and edit, if required. Note: If you wish to add notes to an
examination, there is a separate Notes Panel which will become available once
you have opened an examination.

e Zoom. There are two options for this.

e Select the slider to adjust the Zoom or
Select the button to toggle between size-to-fit display or previous zoom level.
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Image Size. This is only useful if you have more than one patient image open at
the same time. If multiple windows are visible, click Maximize Control to expand
the window to fill the whole patient image viewing area. The Control then toggles
to become the Minimize Control. Click the Minimize Control to make the window
share the space with all the other images. Hide image will close the image which
can then be reopened by returning to the Examination Screen.

Close image. This closes the window. Note: any work done in the window is lost,
so if you re-open the window, it will not be in the same state as it was in when it
was closed.

Option Panel. Used for a group of options where only options appropriate to
current image status can be selected. This would include Scaling Tools, Planning
Wizards, Reduction Facilities and Templating Selections.

Image Area. Displays up to four opened X-rays at one time.

SmartHelp. Context sensitive assistance when required.

Control Panels

The Control Panel controls the current state of OrthoView and changes as you use
OrthoView. This panel can be:

InBasket (not all versions) - controls access to patient information and patient
images.
Procedure Selector — allows the user to select a procedure or service.
Examination Panel — Displays the following:

0  Current procedures and services in use.

o Patient x-ray images.

o0 The preoperative report.
Notes - allows notes to be made during analyzing.
Report - displays a report of your procedure.
Scale Panel - scales the selected patient image.
Analyze Panel — uses wizards to help identify skeletal landmarks.
Simulate Panel (Orthognathic only)- Simulate skeletal movements within the
cranial, maxillary and mandible regions in the Simulate Panel.
Reduce Panel (Orthopaedic only)- allows Fracture Management using Image
Reduction and/or Limb Deformity Correction using procedure-specific wizards,
tools and animators.
Template Panel (Orthopaedic only) - controls the displayed template size.
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Hiding displays

Many individual displays within the software can be minimized to allow better
display of adjacent areas. Such displays have an arrowhead icon P beside their
title. Clicking this arrowhead will hide that display. The arrowhead will change to
another shape w» and clicking that arrowhead will make that display visible again.

Each control panel has various controls on it, and these are explained in further
detail in the corresponding panel sections of SmartHelp.

With the exception of the InBasket panel, the other main panels within the
software contain generally available buttons which allow you to switch between
views and actions.

Generally available buttons

Several buttons are provided along the top of the active panel on either side of
the toolbar. These help you control the active panel and allow you to move to
other parts of the program or apply tools to the active image. They are described
in the SmartHelp.

Loading images

This consists of selecting and then opening one or more images. OrthoView can
display up to four images at the same time. For hips and shoulders, you need a
single AP or PA image unless you are also intending to work with an ML or LM
view. For knees you will normally need two images - an AP (or PA) and an ML (or
LM) view.

Note: In order to load and query from a PACS system, links must be established
between OrthoView and the PACS system using the Preferences panel in
OrthoView. The PACS system also will need to be setup to connect to OrthoView.

Drawing

Most of the things you do in OrthoView involve manipulating various types of
drawings over an x-ray. These drawings include tools, wizards and templates.
This section tells you about the common themes that run through manipulating all
of these.

Everything that is displayed above an x-ray is called a figure. Each of these has
at least one handle and some other graphical elements such as lines, curves and
text. The selected figure is normally the last one you created or changed. Note:
you can only select one figure at a time.
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All handles define a single point, usually in the center, from which the body takes
its position. To make them visible, handles display as a shape that is larger than
the point.

You can tell which figure is selected because the handles will be more obvious;
they change from a tiny dot to a square, cross or some other shape. The selected
figure is the one which is deleted when you press Delete or moves when an
arrow is pressed.

Exportable Image Area

If an image is zoomed out so that the X-ray does not occupy the whole displayed
image area the User can add figures such as Annotations, Lines etc onto the
additional area. There is a limit to how much additional space can be exported
when Saving or Printing and if the exportable area is less than the overall viewing
size of the image window a dotted line will be displayed within the image window.

Any figures that extend beyond the dotted line will be "cut" at approximately that
point.

The first image shows the image window as seen within OrthoView

This will not be exported

This will be exported -

*- Fhig lime-will be cot-off

Figure 1
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The example below shows the likely final output exported by OrthoView.

Figure 2

Selecting/Moving a figure

Selecting a figure:

To select a figure, left-click any part of it with the mouse. Any other figure
that was selected will become deselected. To deselect all figures left-click
somewhere on the x-ray that is not inside a figure.

Moving a figure with the mouse

Use the mouse anywhere on the figure, except inside a handle. Keep the
mouse button pressed and move it, so the figure follows the mouse
pointer. Note: in templates and wizards, this motion may sometimes be
constrained such that the figure slides along an axis. When it is in the
correct position, release the mouse. The figure remains selected.

Moving a figure with the keys

Select the figure with the mouse then press an arrow key. The figure
moves by small increments. If you hold the shift key down and then press
an arrow key, the figure moves further in the arrow direction.
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Modifying or deleting a figure

Modifying a figure

Most figures (except templates and annotations) can be modified by
dragging their handles. To do this, press the mouse button down on the
handle and then move the mouse. The 'hot point' of the handle follows the
mouse cursor. There are several things to notice in this process:

. As soon as you press the mouse button anywhere on the handle, the
handle moves so that its defining point lies under the mouse cursor.

. Sometimes a handle lies inside another figure. When this happens, it
can be difficult to select it. To resolve this, select the figure and click
anywhere not inside the other figure: this selects all of the handles.
You are now able to click the handle of your choice.

Deleting a figure

Select the figure with the mouse and press Delete or Backspace. The
figure is deleted. Note: Wizards and Templates cannot be deleted.

Meters

Many wizards and tools display numbers derived from the positions of the
handles. The value displayed depends upon the tool or wizard, but is either a
distance in millimetres or angles in degrees.

Many Meters are also buttons.

™ e
In the Scaling panel, click either the Ej'N'l’:CircIe Meter or D\: Line Meter tool,
and enter the known size: for example, 30.5 mm. OrthoView then
automatically scales the x-ray to the correct magnification factor.

In the Analyzing and Templating panel, right click a Meter (except those that
are parts of wizards) to display a dialog box that allows you to attach an
annotation to it. This results in the report and the tool tip displaying the
annotation.

Left clicking on Meters where values can be changed (such as Axis Definers) will
open a dialog so that a new value can be entered. In most cases the input value
is restricted to sensible values.

If handles or small items become hidden behind meters, you can temporarily hide
all Meters: to do this use <CTRL><M> which toggles between hide and show

meters.
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Layering

If you have multiple tools or wizards and they overlay each other they can be
individually arranged and brought forwards or backwards in respect to each other
for the active item by selecting arrange from the right click drop down and
selecting your requirements from the available options. When using a default
properties box these options are displayed as buttons.

TABLE 4
' Bring to Front
+ Bring Forwards
d Send Backwards
Al Send to Back

Show/Hide Panels

The default view is to display the Control panel on the left, the Image viewing
area in the center and the SmartHelp on the right of the screen. To hide the
Control or SmartHelp and increase the Image viewing area, click 2 Hide Panel.

The panel will then be hidden until you click £ Show Panel to toggle the view
back to display the hidden panel and the viewing area.

Drag Bar

Additionally, the bar between the image display and options can be dragged to
make either the options panel or image display larger. Hover the mouse over the
bar and the cursor will change to a horizontal double arrow. Drag the mouse
cursor to adjust the desired view.

Image Windows

The Image viewing area within OrthoView is where opened patient X-rays are
displayed. A maximum of four views can be opened simultaneously.

Each window can be maximized to fill the complete image area or minimized to
display all four.

Using either the Window menu, or the controls on the image title bar, you can
control the individual windows, using Toggle Zoom, Zoom, Hide,
Maximize/Minimize and Close.
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Working with the X-ray Image Windows

By default X-ray windows are opened in a "Size to fit" mode (this can be disabled
in the Preferences). Zooming will increase the magnification of the X-ray and
display scroll bars to pan (move) around the work space. To pan, either use the
side scroll bars or click and drag on the image.

Zooming out will reduce the X-ray and display a black canvas around it. This
canvas area can be used to position tool, wizards, templates or image reduction
fragments that are not, or cannot be, superimposed on the X-ray image.

Using the Toolbar

The tool bar is located above the image panel. It contains a collection of drawing,
measuring and presentation tools. Only one of any of the tools can be selected at
a time. Drawing and measuring tools are aligned in a row starting from the left,
and presentation tools are on the right. Use the toolbar icons to determine what
happens when you click or drag the mouse on the patient image.

Note: Tools used for further image manipulation are located in the scaling panel.

Tool Status

When a tool is selected, the icon changes to the selected state. These are
examples of the status of the Pointer Tool:

TABLE 5

Pointer tool available for selection.

R

]

The individual tools are described within SmartHelp.

Pointer tool selected (Active for use)
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Setting Default Tool Properties

Tool properties can be set by selecting the item on toolbar and using a right click
on the mouse to open the default properties window for that specific tool. This will
affect all future instances of that tool until changed. Example for angle tool:

TABLE 6
Label: <text>
Show meters: On/Off
Show bisector: On/Off
Color Select
Arrange: see Layering

On-image tool properties

Properties of tool already drawn on an image can be assigned individual
characteristics by a right click on a handle of the tool already present on an
image. A window display opens to add/remove features for the specific tool,
display help or display properties box as required. Example for angle tool:

TABLE 7
Label... <text>

On/Off Show meters

On/Off Show bisector

On/Off Lock Position

Select Color

Arrange see Layering

Help... Show help

The default property options listed also apply to specific tools applied to an image.
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Keyboard Shortcuts

Keyboard shortcuts allow you to perform menu actions with a single keystroke,
making OrthoView even quicker and simpler to use. To use a shortcut key, hold
down the Modifier Keys indicated below, and then press the key. (Not all options
are available in all builds)

Windows Modifier Keys are:
<CTRL> (Control keys at either end of the keyboard).
<ALT> (either of the Alt keys).
<SHIFT> (either of the shift keys).

or a combination of the above.

OS X Modifier Keys are:
<CMD> (Control keys at either end of the keyboard).
<OPT> (either of the Option keys — Sometimes labelled <Alt>).
<SHIFT> (either of the shift keys).

or a combination of the above.

The following table tells you which shortcuts are generally available.

TABLE 8
Windows Keys Action OS X Keys
<CTRL><R> View the Preferences Panel <CMD><,> (comma)
<CTRL><T> Open Template Management <CMD><T>
Panel
<CTRL><U> Open User Management Panel <CMD><U>
<CTRL><M> Show/Hide Meters <CTRL><M>
<CTRL><P> Print Report <CMD> <P>
<CTRL> <ALT><P> | Print current x-ray complete with <CMD><OPT><P>
superimposed items
<CTRL><E> Quit program <CMD><Q>
<CTRL ><Z> Undo last action (or actions) of <CMD><Z>
tool or wizard applied to image
<CTRL><Y> Redo last Undone action(s) of tool <CMD><Y>
or wizard
<CTRL><0> Display image in size to fit display <CMD><0> (zero)
window
<CTRL><-> (minus) Zoom-out on current image <SHIFT><CMD><,> (comma)
<CTRL><+> (plus) Zoome-in on current image <SHIFT><CMD><.> (period)
<F1> Display contextual help screen if <FN><F1>
not already displayed
<S> Toggle “Snap To” ON or OFF <S>
<space bar> Toggle “Blue Lens” ON/OFF <space bar>
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OrthoView Work Process

OrthoView is used in four stages for orthopaedic planning. When Orthognathic
planning is selected the Reduce Panel is replaced with the Simulate Panel and
the Template panel is removed.

Note: Reduction during Elective Hip procedures can be performed directly within
the Template Panel.

Scaling stage

The scale of the x-ray must be established. In the ideal situation the x-ray is
scaled from a marker or ruler of known size in the correct plane.

Analyze stage

Anatomical wizards have been designed to allow quick identification of key
bony land marks.

Orthopaedics only: Once the wizards have been placed OrthoView
recommends the template most likely to fit, and inserts it in the correct position
(this is done in the Template Panel).

Note: It is not necessary to use the planning wizards. If scaling is complete it is
possible to go directly to the Templating stage.

Reduction stage (Orthopaedic only)

The reduction screen is used to animate limb deformity wizards used in the
analzying screen previously described and also supports the image fragment tool
for moving bone fragments for re-alignment.

Simulate stage (Orthognathic only)

The simulate screen is used to animate facial reconstruction of both soft and hard
tissues.

Templating stage (Orthopaedic only)

The chosen template is then inserted and automatically placed on the x-ray in the
correct position according to the wizard. All the suggested sizes and positions are
easily changed and adjusted. The final templating solution can be saved with the
patient image as part of the patient's electronic record.
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Templating and Planning with OrthoView

OrthoView has a variety of methods to help a surgeon plan for many types of
procedures. Elective, deformity and fracture are available to plan within
OrthoView with a choice of digital templates, wizards and tools to help choose
the correct type and size of implant.

3D services are also available; if selected the user is taken to an external site

where a number of different custom made 3D options can be purchased
depending on the patient's needs.

The Examination Panel

The Examination panel is used to select the Procedure & Services and the X-ray
images. To add an additional Procedure or Service click the {} add icon.

To start planning, in the Examination List select the patient and click Open.

Selecting a Procedure & 3D Service

A procedure or 3D service is selected initially from the following dialog:

Procedure selection:

« . T N W

Procedure Selector

Deformity

A

Fracture

Patient-specific Solutions (3D)

Hip Resurfacing
This procedure is not availsble a5 you do not have the required

tamrlztes installad

Femoral Neck Replacement
This procedure is not available as you do not have the required
r =tztiza

mrnniztas in

Elective Procedures

-

Learn More H Add Procedure ” Cancel ]

Figure 3
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Starting from left to right:

(1) Select either Elective (blue skeleton tab), Deformity (green skeleton tab) or
Fracture (red skeleton tab).

(2) Click the desired part of the body (hovering with the mouse displays the body
part e.g. “Hip”)

(3) Click the chosen procedure or 3D service on the side of the patient to plan
with (double clicking opens up the x-ray panel instantly only for non 3D
services); the chosen procedure or 3D service will be highlighted (as shown
in the image above “Total Hip Replacement”).

(4) Click “Add Procedure” at the bottom right of the dialogue if you have selected
a procedure, this will open up the x-ray panel. If you have selected a 3D
service click “Open Service”, this will take you to an external site.

Note: you cannot begin scaling/analyzing/templating until you have
selected a procedure.

Select X-rays to Open

You also need to select the patient image or images that you are going to
template. You do this by selecting the file names under Select X-rays to open
section.

This area displays the patient x-ray in the examination. To preview an x-ray,
under Select X-rays to open, select the x-ray's name. A preview of the x-ray is
then displayed.

To select a single patient image for templating, double-click its name.
Alternatively, select the image's name and click Open Selected X-rays. To select
more than one patient image for templating, press <CTRL/ CMD> and click to
select all the images you want to open. When all the required x-rays are selected,
click Open Selected X-rays.

The selected image(s) will open. If multiple images are opened, one of them will
be the "Current” one and is clearly selected.

The panel to the left hand side will reflect the state of the currently selected
window

To change which window is selected, click the window's header. Alternatively, you
can use the Window menu and/or the controls at the top right hand corner of the
images to display only the current window or to show both/all of them at once.
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The Scale Panel

From here you establish the x-ray type and calibrate the image. This stage is
critical because, even if the size of the x-ray film/plate is known, the anatomical
features will have been magnified by a factor that depends upon the setup of the
x-ray machine and the size of the patient.

Scaling options are described within the SmartHelp.

Note: Once scaling is complete your scaled image(s) will be automatically moved
into the analyze or reduce panel so you can continue your work in the appropriate
Panel.

The Analyze Panel

Depending on your selection of procedure from the blue, green or red patient
representations in the Examination Panel, after Scaling you will be presented
with the Analyze Panel or the Reduce (Orthopaedic only)/Simulate (Orthognathic
only) Panel.

Using the Analyze Panel you can take measurements from anatomical features
of the patient image with the meter tools and/or by using one or more of the
specialized wizards for the anatomical area you are working with.

Select the appropriate tool in the tool bar, click-and-drag the tool over the patient
image: or, under Wizards, select the wizard you want to use.

Panel Controls

In addition to the Generally Available Buttons there are specific Planning Controls
displayed immediately below the procedure tabs. These are described in the
SmartHelp.

Help with Planning

To plan the procedure, you need to select the correct measurement tools, or
wizards, and then position them on the patient image. This information is then
visible as a tool tip and is displayed in the preoperative report.

IMPORTANT: The measurements displayed in the meters sometimes get in the

way. You can show or hide them at any point. To do this, on the Windows menu,
click Show/Hide Meters: alternatively, press <CTRL><M>

Using the Toolbar
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To select a tool, such as line or circle, select the appropriate tool from the
tool bar. To create measurements, click or drag the tool over the
appropriate area on the patient image. If you need to create a
measurement in a position already occupied by something else, create it
in an empty position and then drag it into place.

Moving and re-sizing measurements

To select a measurement tool, click anywhere on it. All measurements
tools, such as a line or circle, have one or more handles. When a tool is
selected, the handle(s) are displayed as hollow boxes. Only when a tool is
selected can you re-size it.

Changing atool’s size, position or properties

To change the size and position of a tool, click to select the tool and then
use the handles to re-size it. To change the tool’s position, without
changing the tool’s size, click to select the tool, making sure you do not
click a handle and pressing the left mouse button with the mouse pointer
on the tool, drag the tool to the required position.

Right-clicking on a tool will display a menu which will allow settings to be
changed or for the tool to be locked. A property box can also be selected
which will remain on the screen until closed. Selecting a different tool (or
wizard) while the property box is displayed will change the display to the
newly selected tool or wizard.

Circular tools are re-sized differently: click to select the tool and right-click.
The circular tool re-sizes itself so that the circumference passes through
the mouse position. If you right-click anywhere inside the circle it also re-
sizes it, so that the circumference passes through the selected point.

Sometimes handles can get lost behind the meter display. You can
temporarily hide all of the meters by using <CTRL><M> on the keyboard
or selecting Hide Meters in the Image menu.

Clearing a selection and deleting tools

To clear the selection, click anywhere on the patient image, away from the
tool: when a tool is not selected, the handles display as small solid

squares.
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To delete a selection, click to select the tool and either press Delete or
Backspace.

Orthognathic only: Reset landmark positions by clicking #™ the
Reset Positions icon. -

Annotating tools

From either the Analyze or Template panels, click the meter’s label to
display a dialog box, which allows you to enter the required text. Note: the
text you enter is displayed as a tool tip when you position the mouse over
the label. The annotated value of the meter is also displayed in any
reports that you print.

Messages area (Orthopaedic only)

The display area shows OrthoView’s current state. For example, when
you use the Transischial Line Wizard the following information is
displayed, when available:

Preoperative values.
Plan shortening.
Predicted distance between two legs after surgery.

Measurements

Measurements are displayed on the left of the x-ray image providing the
user has set the wizards appropriately.

The measurements calculated by the wizards are also displayed in the
Report Panel.

Orthopaedic only:
Individual results can be removed from display by clicking the@ Hide icon.

The ~Show all button restores the results to the display.
Orthognathic only

Measurements can be shown and hidden using a collapsible tick box

Select Template

If you have selected an elective procedure, the digital templates for the
prosthesis you normally use are displayed. If you want to use a different
prosthesis for this procedure, click the template banner so that the 'Select
a digital template’ dialog box is displayed. The dialog box will first list your
recently used templates, with a full list underneath. You can use the
search box to help find a template. Locate the required template and click
to select the preferred prosthesis. If there are no other suitable prostheses
then only the current one will be shown.
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The Reduce Panel (Orthopaedic only)

Using the Reduce Panel you can access the image reduction tool for
manipulating image fragments and/or specialized animators for limb deformity
procedures.

The toolbar remains available to take measurements from anatomical features on
the patient image with the meter tools and/or by using one or more of the
specialized wizards for the current procedure.

Using the Reduce Panel you can also plan fracture reduction by using the image
fragment tool which is accessed from the Reduce Panel. (All other normal
planning tools are available from the toolbar)

Select the appropriate tool in the tool bar, click-and-drag the tool over the patient
image: or, under Wizards, select the wizard you want to use.

If your procedure includes templates that you selected in the examination panel
then once you have completed your Reduction Planning you can access the
Templating Panel by clicking the appropriate selection above the image.

Display Area

The display area shows OrthoView’s current state. For example, if you are
using the Limb Deformity animators there will be handles displayed to
animate your planned reduction.

Image Region Tool

This is an additional tool only available in the Reduce Panel which is described
in the SmartHelp.
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The Simulate Panel (Orthognathic only)

Using the Simulate Panel you can access the Facial Repositioning and Cut
tools for manipulating image fragments for Orthognathic reconstruction.

The toolbar remains available to take measurements from anatomical features
on the patient image with the meter tools and/or by using one or more of the
specialized wizards for the current procedure (All other normal planning tools
are available from the toolbar).

No templates are available within the Simulate Panel.

For more information on how to use the Simulate Panel please refer to the

SmartHelp.
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The Template Panel (Orthopaedic only)

In the Templating panel, you insert Templates on to the patient image. To insert
Templates, select the options for the Template you want to view on the patient

image from the selection panel.

Additional Controls

“ Accept Recommendations - OrthoView Wizards when correctly applied can
make recommendations for some Template Options. If you have already elected
to accept recommendations in your Templating Options within your Preferences

then this control will not be visible.

When templating a Hip Procedure, additional controls may be available.

Reduction - This will articulate the Head. When

.;"I.I'JL activated, the option will change to
K 4
'I' Remove Reduction - This will undo the reduction

(When selected the option will return to Reduction)

Figure 4

When templating a Knee Procedure, additional controls may be available.

Reduction - This will articulate the Head. When

| 3 activated, the option will change to
oyt
#{- Remove Reduction - This will undo the reduction
(When selected the option will return to Reduction)
Figure 5

Automatic display of Templates

Meridian Technique Ltd Appendix Number | Total Pages Page Number
OrthoView 7.2 - 510k Notification 24 62 30
September 22, 2017




If the current examination includes one or more digital templates OrthoView will
immediately display the template outline(s) in the Template Panel. In most cases
this will not be a fully specified Template. See Prosthesis Options below for
further details.

Selecting Alternative Template

By clicking on the template banner any other templates available for that
group of prostheses for example Hip Stems will be visible and an
alternative can be selected and positioned.

Prosthesis Options

The various options for the selected digital Template for the current
procedure are displayed in option areas that can be minimized (on a
complete component assembly basis) if required. This is achieved by
selecting the hide or show icons previously described.

Where more than one component assembly is available (e.g. Acetabular
Cup and Femoral Stem) then these options areas can be individually
minimized. This is useful when there are several options for a component
which are not always easily available when all prosthesis option displays
are visible.

Until all options for all available prostheses for the active procedure are
selected by the user, any incomplete component is displayed with a feint
outline and an 'incomplete' warning is also shown.

¢ If the Preference to accept recommendations is set and
appropriate wizards have been used, then the displayed
component options will be preselected based on those criteria and
other options that OrthoView cannot recommend will be
preselected with a red dashed outline in that option list panel, and
the panel background will also be shaded.

¢ Where the user has elected not to accept any recommendations or
no appropriate wizards have been used, these options will not be
preselected and all options will be denoted by red dashed outlines
and the panel backgrounds will also be shaded.

Important: In either of the above situations, the User must select clinically
appropriate combinations of options before OrthoView will display a full
outline of the component. When this is done, the component outline will
become darker. The 'incomplete’ warning for the entire procedure will only
be removed when all unspecified component options (as denoted by red
dashed boxes and shaded panel backgrounds) have been correctly
specified.
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Prosthesis Properties

Selecting the Prosthesis Properties box allows the properties for the
current prosthesis component to be adjusted.

e The Color option allows the user to select the color for this
prosthesis component.

e The Arrange option allows template, tools and wizards to be
layered.

e The Lock option locks this component in this procedure to prevent it
being unintentionally moved on the image. (The Laterality and Color
can still be changed even when locked)

¢ The Show option toggles the display (Hide/Show) of this
component. It can be made visible again using the Hide/Show icon
from the Templating Panel.

e Help displays help for the specific component.

e The Properties option displays a property box on the image for this
component. This box will remain open until closed and will change
dependent on which component is selected.

Additional Prosthesis Controls

There are additional template controls within the Prosthesis Selector
panel for each individual prosthesis dependent on the type of procedure
and any wizards used.

These include buttons for aligning the templates to appropriate wizards
and bending (or canceling bending) of suitable plates. (Other buttons may
also be available and their purpose will be self-explanatory)
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Moving Templates on the Screen

Automatic Positioning of Smart Templates

If the planning wizards have been used, generally for arthroplasty, the first

template set will be sized and positioned by OrthoView.

¢ OrthoView will size and position the digital templates. Final
adjustments to the position or size of the templates may be
made by selecting different options.

e To make the digital templates hide or show on multiple x-ray
images, select Hide/Show icon for the individual template
component. This icon is located to the right of the template
banner above the padlock symbol and resembles an eye.

Hip Reduction

In Hip examinations with Acetabular and Femoral Head
components, OrthoView enables the user to Articulate the Femoral
Head within the Acetabular component in order to animate the
proposed reduction.

Once enabled using the ~*'Articulate button, the femoral stem can
be adjusted by dragging using the mouse to compensate final
fixation. The Femoral component will remain locked to the
acetabular component during this process. The entire component
assembly of Stem and Cup can also be adjusted by dragging the
Acetabular cup component using the mouse.

Any changes to leg length discrepancy or offset during these
adjustments will be reflected in the results panel.

Selecting the #*' Unarticulate button will undo any changes.

Surgical Knee Options

Depending on the settings within the Preferences, the posterior or
anterior referencing selection for knees is evident in the ML
Femoral prosthesis positioning. As the template size is altered it
references to the anterior femoral surface or posterior condyle
surface.
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Aligning Smart Templates to wizards

When more than one prosthesis set is added to an image, or when
manually positioning additional template sets, it will be necessary to align
the additional components to the position of the wizard. Using this button
will move an unlocked prosthesis component to the wizard position.
(Prosthesis sets are, by default, unlocked when first selected)

Manual Positioning of Templates

If the planning wizards have been omitted, manual sizing and
positioning of the smart template proceeds as if it were an acetate
template.

To make the graphics appear on the image if the planning wizards
have not been used, make a choice from each of the tables listed to
the left of the Image display under the digital template banners. The
graphics will appear in a random position. To move the templates use
the mouse as directed below.

To move the template along the line of axis indicated by the broken
line, move the mouse cursor inside the template, click and drag with
the left mouse key.

To move the digital template freely about the image, click and drag the
four point star with the left mouse key.

To rotate the template move the mouse cursor inside the template,
click and drag with the right mouse key and a red line appears during
this action.

To make fine rotational adjustments hold down the <CTRL/CMD> key
and use the right or left arrow keys.

For fine positional adjustments use the arrow keys on the keyboard.

Manual Sizing of Templates for Arthroplasty

To make size and type adjustments to the templates make selections
from the tables to the left of the Image display. Note that the graphics
will reflect the adjustments made, but the position of the digital
template does not change.

The smart templates incorporate the surgical guides so, for a specific
prosthesis, only the combination of choices displayed in bold within
the tables are available. If a combination of user choices is not
physically available from the manufacturer, OrthoView will display a
warning and remove the graphics.
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The example below shows the elbow joint templated with manual sizing and positioning.

Figure 6 Figure 7

Positioning and Sizing of Templates for Trauma Fixation

o Choose a sizing option from the Prosthesis Selector under the digital
template banner.

¢ Click on the four point star handle and drag one end of the template
into an appropriate position on the bone. Change side or orientation
as required.

e Smart Template: Use the arrow ended handle to drag the plate or
nail to the appropriate length and OrthoView will adjust the prosthesis
graphic to the nearest matching size for you rather than needing to
change it manually in the selector panel. Screws behave in the same
way, snapping to the length options available from the manufacturer,
as you click and drag the arrow ended handle away from the screw
head.

o Basic Template: Any changes for size (etc) must be made manually
from the selection panel.

The displayed sizes or lengths etc., shown on a component can be switched
on or off by using the Hide Meters keyboard shortcut. <CTRL><M>
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Figure 8

Template Properties

There are properties associated with all templates and they can be
accessed by either right clicking on the template graphic or by using the
drop down box to the right of the template banner in the Prosthesis
Selector panel.

Default Template Properties

These are the usual options available from the dialog obtained by right-
clicking on the template graphic and also in the dialog box subsequently
displayed by selecting Properties.

e Color - choose the template graphic color from the selection
offered, useful if multiple templates are used to avoid
confusion.

¢ Orientation - where appropriate, allows setting the template
view to anterior, posterior, lateral or medial. Useful when not
templating in the expected plane. (This option not available for
all prostheses)

o Lock - fixes the template position, toggle to allow movement
again.

e Show - hides the template, this can also be done by clicking
the colored button next to the template banner. Toggle to show
again.

e Arrange - Arrange multiple templates in front or behind each
other.

e Help — displays contextual help.

e Properties - if selected, a dialog box remains on the screen
until the 'X' is clicked to close.
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Basic templates have an additional option to add required screws.

Properties Dialog Box for Screws

These are accessed by right clicking on the screw graphic and the
following options are available.

e Type - one of the various types can be selected including none
if this screw is not required.

e Insertion Order - the order of insertion in the plate can be
associated with each screw.

o Properties - a properties dialog box will remain open if
selected.

Basic Screw Templates have additional options to change the screw
diameter or delete the screw from examination.

General Screw Behavior

Screws can be added to all templates that accept the addition of screws.
In basic templates screws initially appear Lateral-Medial and the user
must adjust appropriately.

Screws can be moved and positioned by dragging on the outline. Screws
can be lengthened and shortened by pulling the tip handle, even when the
associated template is locked.

Screws can be rotated by the tip handle and rotated around the screw
head. Smart templates allow only manufacturer approved angle of
rotation. Basic screw templates have no restriction.

Most screws can have their type and insertion order changed. Additionally,
basic screw templates can have their diameter changed.

Screw lengths are displayed in meters on the tip of the screw. Clicking this
meter allows the insertion order to be added.

Meridian Technique Ltd Appendix Number | Total Pages Page Number
OrthoView 7.2 - 510k Notification 24 62 37
September 22, 2017




Unknown Screw Types

The functionality for displaying screw types within OrthoView is constantly
updated. If OrthoView displays a digital template containing a screw type
that your version of OrthoView is currently unaware of then a green screw
outline will be displayed.

Each list of individual prosthesis sizes (etc) displays all the possible
values for a single parameter: offset, diameter, and so on. If you used a
wizard, some entries in the lists might be already selected in blue. This
selection provides you with a suggestion of the size of component that
might be appropriate. This suggestion is based upon the wizard position
and the recommendations from the Orthopaedic prosthesis manufacturer.

You can modify your Template selection at any time using the mouse. To
select alternative list entries, either click to select the required option or
use the UP or DOWN arrows.

Adjusting screws

The screws will maintain their correct angle to the plate as specified by
manufacturer. The screw length, type and insertion order can be changed
in the normal way by right clicking on the screw to open screw properties
dialog.

Changing the size of the plate during bending via the template selection
panel will, in the case of bigger templates, extend the plate to the new
bigger size where further bending can be performed. In the case of
selecting a smaller template, the current bending of plate beyond the new
smaller size, will be lost.

If you wish to straighten the plate without changing size, select <Cancel
bending> from the Prosthesis selector panel (There is no undo option for
individual bends)

Details of the bend angle and direction of each bend is available in the
Report
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Menus

OrthoView has been designed to be intuitive to the user. Software tools in the
Control Panels can be sufficient to do standard planning sessions. If you need to
go back and re-check your work, in earlier screens, or to manage multiple patient
images, you can use the menus or the tabs across the top of each individual
image display panel.

The Menus are organized into broad categories, making it easy to find the
appropriate function.

OS X OrthoView Menu

(not available in Windows)

TABLE 9

About OrthoView Displays the About Panel
Preferences Opens the Preferences Panel
<CMD><,> (comma)

Services OS X Services

Hide OrthoView Hide the OrthoView window
<CMD><H>

Hide Others Hide other application windows
<OPT><CMD><H>

Show All Display all application windows
Quit OrthoView Quits OrthoView

<CMD><Q>

File Menu

This menu contains items that allow you to work with external files.

TABLE 10
Windows Keys Action OS X Keys
Preferences Opens the Preferences Panel See OS X OrthoView Menu
<CTRL><R>
Template Opens the Template Management <CMD><T>
Management Panel
<CTRL><T>
User Management | Opens the User Management Panel <CMD><U>
<CTRL><U>
Open Opens the selected X-ray from the Open
Examination List that the InBasket is
pointing to. (InBasket versions only).
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TABLE 10

Windows Keys Action OS X Keys
Import Folder Import an examination from a specific Import Folder
Folder
Import DICOM CD | Import examination(s) from a Dicom Import DICOM CD
CD Drive.
Query PACS Import specific examination(s) from a Query PACS
PACS system using the Query and
Retrieve dialog
Add Image Adds an image to the currently open Add Image
examination. Look at the Examination
Panel to work with it. (InBasket
versions only)
Page Setup Sets the printing settings Page Setup
Print Report Print a Report for the opened <CMD><P>
<CTRL><P> examination

Save Report

Saves a Report in JPEG, for the
opened examination

Save Report

Print Current x-ray
<CTRL><ALT><P>

Print the current x-ray together with <ALT><CMD><P>
any Templates or planning tools

displayed on it

Save Current x-ray

Use to save an x-ray Save Current x-ray

Exit
<CTRL> <E>

Quits OrthoView See OS X OrthoView Menu

Panel Menu

This menu contains access to the main Control Panels

TABLE 11
Examination Displays the Examination Panel for the selected examination
Notes Displays the Notes panel for the current procedure
Report Displays the Report panel for the current procedure
Scale Displays the Scale Panel for the selected window. This is
unavailable if you have not selected an image
Analyze Displays the Analyze Panel for the selected window. Unavailable
until you have scaled
Simulate Displays the Simulate panel for the selected window (Orthognathic
only)
Reduce Displays the Reduce screen. This screen replaces the Analyze
Panel if Fracture Management has been selected. It is unavailable
until you have scaled. (Orthopaedic only)
Template Displays the Template Panel for the selected window. Unavailable

until you have scaled (Orthopaedic only)
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Image Menu

This menu controls the active image

TABLE 12
Windows Keys Action OS X Keys
Undo Undo last action(s) of tool or <CMD><Z>
<CTRL><Z> wizard applied to image
Redo Redo last Undone action(s) of <SHIFT><CMD><Z>
<CTRL><Y> tool or wizard
Flip Horizontal Flips image horizontal Flip Horizontal
Flip Vertical Flips image vertical Flip Vertical
Rotate 90deg Rotates image 90 degrees Rotate 90deg Clockwise
Clockwise clockwise
Rotate 90deg Rotates image 90 degrees Rotate 90deg Anticlockwise
Anticlockwise anticlockwise
Reset Window and | Resets contrast and brightness | Reset Window and Leveling
Leveling to original setting
Size to Fit Resize image to best fit available <CMD><0> (zero)
<CTRL><0> window
Zoom In Make image larger <SHIFT><CMD><.> (period)
<CTRL><=>
Zoom Out Make image smaller <SHIFT><CMD><,> (comma)
<CTRL><-> (minus)
Hide Meters Hides or shows meters on the <CTRL><M>
<CTRL><M> selected window
Hide Screws Hides or shows screws on the <CTRL> <S>
<CTRL><S> selected window
Window Menu
This menu controls the windows
TABLE 13
Windows Keys Action OS X Keys
Toggle Full Screen <CTRL><CMD><F>
Expand Window | Expand the selected window to Expand Window
be only one visible.
Next Window Tabs to the next open window Next Window
Hide Window Hides the selected window Hide Window
Close Window

Closes the selected window

Close Window

<Window Name>

Selects that window

<Window Name>
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Help Menu

This menu accesses the OrthoView SmartHelp System

TABLE 14
Windows Keys Action OS X Keys
Not available in Search OS X Spotlight Search
Windows
What do | do next? | Accesses the relevant Help for <FN><F1>
<F1> the area that you are in
Start Here Help displays Introduction to Start Here

OrthoView

Templating with
OrthoView

Help displays Template panel
overview

Templating with OrthoView

Product Support

Help displays Product Support
information

Product Support

Declaration of
Conformity

Help displays Declaration of
Conformity

Declaration of Conformity

Open User Guide

Opens user guide

Open User Guide

Request printed User

Opens form to request printed

Request printed User Guide

Guide user guide
License Manager Starts the license manager License Manager
dialog

Welcome Screen

Activates Welcome Screen

Welcome Screen

About

Displays the About Panel

See OS X OrthoView Menu

The Preference Menu

The various Preference options are fully described within the SmartHelp. These allow
you to configure OrthoView to suit your personal Preferences and work practices.
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Cybersecurity Setup

User Authentication and Access Control
The recommended way of authentication is Windows Authentication.
OrthoView provides a layered authorization model with the following roles:

e Administrators: technical professionals who are entitled to configure and
change the system behaviour

e Users: trained medical professionals intended to create pre-operative plans

Setup the OrthoView Administrators security group

OrthoView comes with a locked and encrypted system configuration for a Windows
security group whose members are granted with OrthoView Administrator role. The
group name by default:

OrthoView Admins

The group has to be added to the Windows Active directory as a security group. The
name can be changed but it requires the assistance of OrthoView Support. It is
recommended this is done right after the installation.

Enable Windows Authentication

Please make sure that the “OrthoView Admins” or the related administrator group has
been created in Windows Active Directory and the current user is a member of that
group. The membership can be checked via running “whoami /groups” in a Windows
command line and manually checking the result. Note: if the Windows security group
has been recently added, you may be required to re-login on the same computer if
there was no logout since. If you miss this step you risk locking yourself out from
OrthoView temporarily.

The steps to enable Windows Authentication:
1. Log into a workstation with a user who is an OrthoView Administrator
Run OrthoView
Click File -> Preferences
Click the Advanced Tab

Tick the Box Windows Authentication

© g k~ w DN

Restart OrthoView

Setup OrthoView Users

OrthoView users can be managed through a GUI panel available for Administrators only.
1. Log in to a workstation with a Windows user who is an OrthoView Administrator
2. Run OrthoView

3. Click File -> User Management
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4. Select the second tab

5. Add, remove or edit the Windows users or groups who are entitled to access
OrthoView with a User role.

Note: in case of managing the users by groups, it is very important to always use
Windows security groups. It will not be possible to use email groups created in Windows
domains as they are designed for other usages.

Channel Encryption

Communication with Remote File Stores

During the installation, Network File Share can be selected as a central data repository.
For the data communication OrthoView recommends and supports Server Message
Block 3.0 and later which provides an end-to-end channel encryption with AES based
signing algorithm.

OrthoView does not contain restrictions on using alternative ways of encrypting the
communication channel toward remote file stores.

Communication with Remote Service Endpoints

Data folder type Can contain PHI |Comments

Software binaries No The binaries are locked for modification
by a timestamped signature, any
malicious alteration is designed to be

detected.

Software configuration No The content is encrypted and locked by
its own.

System configuration No Critical data parts are encrypted in
content but may contain other textual
information.

Prosthesis templates No The files are in a proprietary format

and do not contain PHI.

Workstation application data |Yes It can temporarily contain transactional
PHI data from the PACS during a
planning session.

XRays folders Yes It contains Protected Health

Information.
(if not stored in PACS)

System log (technical) Yes By default any PHI is redacted, an
administrator can configure PHI
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appearance via a GUI.

Audit Log Yes By default any PHI is redacted, an
administrator can configure the level of
PHI association to the log entries via a
GUL.

OrthoView supports and recommends to use Transport Layer Security 1.2 (TLS 1.2)
when communicating with entities over a network.

There are no restrictions on using self-signed certificates, but we recommend complying
with the latest industry standards and regulatory recommendations.

Data Encryption

In general it is recommended that data at rest is encrypted for all application data. This
can be achieved by using storage technologies which support the latest encryption
standards and provide sufficient prevention against physical or malware intrusion.
OrthoView is not bound to a particular technology or vendor.

The Software Data chapter contains the details of the application data folders. The
following table contains a classification by Protected Health Information (PHI):

Data folder type On-access scanning On-demand scanning
Software binaries It may be excluded, any It is recommended to include in
malicious alteration is a regular (periodical) scanning

designed to be detected
(binaries are signhed and
timestamped)

Software configuration It may be excluded, the
content is encrypted by its
own

System configuration It may be excluded, textual

(non-executable) data

Prosthesis templates It may be excluded, it is not
intended to include any
infectable file type

Workstation application data|lt may be excluded, it is not
intended to include any
infectable file type

XRays folders It may be excluded, it is not

_ _ intended to include any
(if not stored in PACS) infectable file type
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System log (technical) It may be excluded, textual
(non-executable) data

Audit Log It may be excluded, textual
(non-executable) data

Anti-Virus Policy

We recommend that all computers where OrthoView is installed or run have an anti-
malware program running. There is no restriction about the program and OrthoView
does not contain a specific integration; the protection must be provided on file level.

The following table can assist with establishing optimal local settings. It is recommended
that the administrators make their own choice at their discretion which complies with the
local IT policy, the actual regulations and the expected business performance or
effectiveness. Under no circumstance do we recommend lowering the security settings if
there is a concern over possible intrusion.

Firewall

The following tables summarize the incoming and outgoing traffic which can appear
during the software usage. The local IT firewall configuration should allow the traffic
mentioned here on workstations where OrthoView has been installed.

Outgoing

Purpose Destination Port Data

DICOM Query |Configured PACS server Configured |DICOM messages and
and Retrieve PACS port |DICOM binary
Windows Domain Controller 88 Kerberos messages

Authentication

Access Configured Network File Share 445 SMB messages and
software data binary files
on a shared

network drive

Automatic live.orthoview.com, 443 HTTPS with JSON
Template content,
Update! s3-us-west-1.amazonaws.com
Binary data
Data Export  [live.orthoview.com, 443 HTTPS with JSON
for Mobile 3 1 content,
Applications? s3-us-west-1.amazonaws.com '
Binary data
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Management?

Case casemanagement.materialise.com, 443 HTTPS with JSON
content,
s3-eu-central-1.amazonaws.com
Binary data

! — Automatic Template Update can be turned off in the system configuration
2 — The feature is not part of the standard installation, available on-demand

Incoming
Purpose Source Port Content Type
DICOM retrieve (C- [Configured PACS server Configured |[DICOM binary
MOVE) C-MOVE
port

Intrusion Detection and Prevention

The following ruleset can be defined to assist the intrusion detection and prevention
systems deployed in the hosting environment:

- The operating system process associated with the software is intended to be relatively
short. The approximate planning time may be 10-30 minutes per case which may
increase on case complexity but must fit into the normal employee schedule (shift or
working hours)

- The software should not run when there is no workforce in the premise (e.g. no
intended midnight activity in a room which is intended to be used daytime only)

- On a workstation, OrthoView is always bound to an active operating system login
session and never appears as a background process

- OrthoView does not communicate with any other remote entities except the ones listed
in the Firewall chapter

- The software does not open any port on a workstation other than the ones listed in the
Firewall chapter

In addition to the above ruleset which can be used instructing the local Intrusion
Detection and Prevention System, OrthoView provides the following cybersecurity
controls to further ensure the safety use of the device:

- The software binaries are signed and timestamped, any malicious alteration is detected
and the software does not start

- The software configuration is locked and encrypted (in content), any alteration is
detected and invalidates the related setting. OrthoView may decide to start if it does not
risk the safety use or the intended use of the device

- Finalised pre-operative plans are immutable, any malicious change in the content is
detected and invalidates the plan.

Meridian Technique Ltd Appendix Number | Total Pages Page Number
OrthoView 7.2 - 510k Notification 24 62 47
September 22, 2017




Prevention Against lllegal Access of an Unattended Machine

OrthoView is intended to be used for a short term pre-operative planning session and the
program terminates after. Please make sure that the use environment has one of the
following group policy in place:

- The workstation should be automatically locked after a configured idle time, or
- The workstation should automatically logs the user off after a configured idle time

We do not recommend using a computer with a commonly known centralised username
and password as it may breach the IT standards and/or the local IT policy. However,
there can be certain situations when the patient safety may overwrite the general rules
e.g. a machine in an operating room which access should not be blocked in case of an
emergency. For those situations we recommend running the local corresponding
cybersecurity measures for addressing any potential illegal access to an unattended
workstation.

Audit Log

OrthoView traces any access to the software together with lifecycle events involving any
type of Protected Health Information. The log is file based and its location is defined in
the Software Data chapter.

The logged actions:
e LOGIN:
e OPEN_EXAM:
¢ OPEN_IMAGE:
e IMPORT_IMAGE:
e IMPORT_EXAM:
e EXPORT_EXAM:
e EXPORT_IMAGE
e PRINT_EXAM:
e RECEIVE_DICOM:
e RETRIEVE_DICOM:
e SEND_DICOM:
e ARCHIVE_EXAM:

The software provides a flexible way of defining the log message granularity when a PHI
has been accessed. It is recommended to choose the smallest set of PHI to be
displayed in the audit log entry which still provides adequate traceability related to the
action. The values which the administrator can select on the GUI:

o Patient ID
o Patient name

e Accession Number
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Examination ID

File name (as it is on the disk)
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Maintenance

Software Data

Local Machine

The following table summarizes the workstation folders which contain OrthoView
controlled data if the selected storage type was “Local Machine” during the installation.

Data folder [Default location Configurable |Estimated Frequency

type Working Size |of change

Software <OS Program Yes' ~250 MB None

binaries Files>/OrthoView/<build ID>

Software <OS Program No ~2-5 kB None

configuration |Files>/OrthoView/<build
ID>/Config

System <OS program data No ~30-250 kB Infrequent

configuration [folder>/OrthoView/<build ID>/*.xml

XRays <OS Program Yes’ Depends on  |Frequent

folders Files>/OrthoView/<Build the number of

. ID>/XRays_* examinations

(if not stored stored there

in PACS)

Prosthesis  [<OS program data No 8kb-450MB Infrequent

templates folder>/OrthoView/Templates

(from

template

delivery

server)

Workstation [<OS program data Yes? 100-200 kB Infrequent

application [folder>/OrthoView/<build ID>

data

System log |<OS program data No Max. 20 MB, [Frequent

(technical)  [folder>/OrthoView/<build rolling
ID>/Logs/OV_<username>_*.txt

Audit Log <OS program data No Depends on  |Frequent
folder>/OrthoView/<build the logged

ID>/Logs/audit.txt

operation meta
data

"Configurable only during the installation

“Configurable on a GUI for administrators if the “Local Machine” storage type was

selected during the installation
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3Configurable only by special config file

Workstation Data - Network File Share Data Storage

During the Installation, the administrator can choose the desired storage type. If the
“Network Shared Folder” was selected, a corresponding network path has been
configured. In this way workstation installations on multiple machines can be connected
and unified under one central configuration and data folder.

The following table contains the data folder locations:

Type Default location Configurable |Estimated Frequency
Working Size [of change
Software <OS Program Yes’ ~250 MB None
binaries Files>/OrthoView/<build ID>
Software <OS Program No ~2-5 kB None
configuration |Files>/OrthoView/<build ID>/Config
System <Network Share Path>/<Build ID> |No ~30-200 kB [Infrequent
configuration
Prosthesis <Network Share Yess 8kb-450MB  |Infrequent
templates Path>/TemplateShare
(NFS
prothessis
templates)
Prosthesis <OS program data No 8kb-450MB  |Infrequent
templates folder>/OrthoView/Templates
(from
template
delivery
server)
XRays folders [<OS Program Yes® Depends on  |Frequent
) Files>/OrthoView/<build 1D>/ the number of
(if not stored examinations
in PACS) XRays_* stored there
System log  |<Network Share No Max. 20 MB, |Frequent
(technical) Path>/Logs/OV_<username>_*.txt rolling
Audit Log <Network Share No Depends on  [Frequent
Path>/Logs/audit.txt the logged
operation
meta data
Local <OS program data No 30-200 kB Infrequent
workstation [folder>/OrthoView/<build ID>
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application
data

NFS <Network Share Path>/ Yess 30kB-450MB | Infrequent

workstation
application
data

‘Configurable only during installation
‘Configurable on a GUI for administrators if the “Network Shared Folder” storage type
was selected during installation

3 Configurable only by special config file

PACS Data

The recommended way of storing patient data and the pre-operative plans is the PACS.
Please refer to the PACS provider documentation to establish the necessary storage

policy.

Backup

The Software Data chapter describes the application folder which are the targeted
backup sources.

Backup the Software Binaries (for local and NFS)

For backing up the software binaries we recommend creating a computer image after
the installation. This is necessary because the software installation procedure creates
registry entries besides the folder data.

The installer must be also preserved to support an alternative restore procedure via
clean installation.

Backup the Application Folders (everything except the software
binaries, for NFS only)

A file system backup is required for the folders listed in the Software Data chapter
(except Software binaries). The table in the chapter summarizes the average size and
the expected frequency of change.

The backup of infrequent data can be a decision of local strategy and configuration.

Folder backup of frequently changing data is recommended on a daily basis, but this can
be less strict if the local policy allows.

Restore

Restore from a Computer Image
If the latest computer image is available, the restore procedure is the following:

1. Restore the computer from the latest system backup image
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2. Restore the application data folders listed in Software Data chapter from the backup
archive

Restore with Installation

If there is no complete computer image available and the software binaries are
damaged, the following steps can be performed:

1. Uninstall the software via the standard operating system provided mechanism
2. Install the software according to the Installation chapter

3. Restore the data folders described in the Software Data chapter from the backup
archive

Restore without Installation (data only)

If the software binaries were not harmed but the application data was damaged, the
restore procedure is the following:

1. Restore the data folders described in the Software Data chapter from the backup
source

Emergency Plan

This chapter provides guidance about restoring the software from an unforeseen
disaster or other damage (like a cybersecurity threat) which may cause major disruption,
and which needs to be resolved immediately in order to restore at least the minimal
software functionality and while avoiding further risks.

Restore OrthoView with Full Functionality and Previous Data

For an immediate restore of the previous fully functional working state, please perform
the following steps:

1. Repair or replace the hardware components to a level which complies at least with
the minimum hardware configuration written in the Minimum System Requirements
chapter

2. Restore the software as written in the Restore section

Restore Minimal Functionality

The minimal functionality of OrthoView involves the functionality covering the intended
use of the software. The main difference that it does not support connectivity to any
external entities, it is intended to work even on isolated hardware and can provide a
resilient way for maintaining the functionality right after a serious disaster ending in sever
damages in the IT networks. The nature of the medical device (software) still requires a
minimum hardware level. The steps are the following:

1. Repair or replace the hardware components to a level which complies at least with
the minimum hardware configuration written in the Minimum System Requirements
chapter

2. Install the software as written in the Installation chapter and select “Local Machine”
as storage

Obtain an image for planning
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1. Locate and export the image(s) of the related study from the PACS system. This is a
PACS specific step; please refer the related vendor provided documentation.

2. Transfer or copy the image into the machine where OrthoView is installed

3. Run OrthoView, use the Import functionality to open the image from the local folder
and preform the intended planning

Open a previously created plan
1. If the plan was previously stored:

a. Inthe PACS: locate the study and the related series in the PACS and export the
previously saved plan. This is a PACS specific step; please refer the related vendor
provided documentation.

b. In a folder: restore the desired plan from the backup source. The folder location is
written in the Software Data chapter.

2. Transfer or copy the plan into the machine where OrthoView is installed

3. Run OrthoView, use the Import functionality to open the plan from the local folder,
and the software will automatically recognise and display the plan.

Patching Policy

Microsoft OS

The policy and best practice for Microsoft OS patches and service packs on a system
where OrthoView is installed is as follows:

There are no know issues with any Microsoft patches or service packs and we
recommend continuing the default update policy of the local IT on site.

Java (prior to OrthoView 6.6.x)

OrthoView is a Java based application and each release is tested with, and validated to
work up to the currently available version of Java. We don’t recommend updating Java
beyond the current recommend maximum tested version for the installed version of
OrthoView. The OrthoView application will display a warning on start-up if it detects a
newer version of Java than it knows about.

Java (OrthoView 6.6.x +)

OrthoView contains an option to use an embedded version of Java that is completely
separate from any other version of Java installed on the system. Any updates to the
system Java will not affect the OrthoView embedded Java.
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Regulatory Standards and Declaration of Conformity

Regulatory Standards

OrthoView™ has been designed to comply with the product standards shown below.
These standards represent requirements for the way in which the design, development
and validation of medical software is carried out. These requirements are embodied in
the Meridian Technique Quality Management System which is accredited to ISO9001
and 1SO13485. OrthoView™ itself cannot be certified to these product standards, but it is
confirmed that OrthoView has been produced in accordance with Meridian Technique’s
ISO9001 and 1SO13485 Quality Management System (See Declaration of Conformity) —
thereby demonstrating compliance with these product standards:

TABLE 15
ISO Standard Standard Title EN Standard
Reference Reference
ISO 9001:2008 Quality Management Systems, Requirements EN ISO
9001:2008
ISO 13485:2003 Medical Devices — Quality Management Systems — EN ISO
Requirements for Regulatory Purposes 13485:2012
CAN/CSA-ISO Medical Devices - Quality Management Systems -
13485-03 (R2013) Requirements for Regulatory Purposes
FDA 21 CFR Part Quality System Regulation (United States)
820
ISO 14971:2007 Medical Devices — Application of Risk Management to EN ISO
Medical Devices 14971:2012
ISO 15223-1:2012 | Medical devices - Symbols to be used with medical device | EN ISO 15223-
labels, labelling and information, Part 1 general 1:2012
requirements
ISO 15223-2:2010 | Medical devices - Symbols to be used with medical device
labels, labelling and information, Part 2 symbol
development selection and validation
Information supplied by the manufacturer of medical BS EN
devices 1041:2008 +
A1:2013
ISO 14155: 2011 Clinical investigation of medical devices for human BS EN ISO
subjects. Good clinical practice 14155:2011
Medical device software — Software life cycle BS EN
62304:2006
Medical devices — Application of usability engineering to BS EN
medical devices 62366:2015
NEMA PS 3.1 - 3.20 (2016) Digital Imaging and
Communications in Medicine (DICOM) Set. Specific
supported functions are detailed in the DICOM
Conformance statement

USA — Prescription Statement (21 CFR 801.109/b/1)

Caution: USA Federal law restricts this device to sale by or on the order of a physician.
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Distributors and Maintenance

Approved distributors and how to obtain service and maintenance

In the first instance, please contact your Customer Support Engineer. In case of difficulty,
please contact the Customer Support Department at Meridian Technique as shown
below:

Manufacturer

Meridian Technique Ltd

2 Venture Road “
Southampton Science Park
Southampton

Hampshire

SO16 7NP

Great Britain

Telephone +44 (0)2380 762 500

email: orthoview.support@materialise.co.uk

Australian Sponsor
Emergo Australia

Level 20, Tower Il

Darling Park

201 Sussex Street
Sydney, NSW 2000
Australia

Accessories

Accessories recommended for use with the equipment

There are no accessories recommended for use with OrthoView™

Installation

Installation and Commissioning
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The installation and commissioning of OrthoView™ is performed by Installation
Engineers as part of the Implementation. As such, you do not have to carry out any

installation of the product.

Explanation of symbols

Symbols Used

The symbols appearing on OrthoView™ are shown below together with their meaning:

TABLE 16

€

0843

This symbol shows that OrthoView™ is marketed as a
medical device in the European Union and that it complies
with all of the applicable requirements of the Medical
Device Directive (93/42 /EEC).

The '0843' is the reference of the assessment body
(Notified Body) used to substantiate the claim. (In this case
UL Int UK)

LOT

This symbol identifies the Lot or Build number of the
software

REF

This symbol identifies the reference of part code/software
release version of OrthoView™

This symbol identifies the date of release of the software.

This symbol identifies the Manufacturer of the software.

The symbol means 'Refer to Accompanying
Documentation.' Wherever it appears, it is drawing your
attention to the fact that you should be fully conversant with
the operation and use of OrthoView and that you should be
familiar with all associated documentation and that you
have documented training acceptable to the authority using
OrthoView™
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Inspection and Maintenance

Preventive inspection and maintenance

OrthoView™ is software only - there are hence no parts requiring inspection, service or
maintenance.

The software does not require calibration.

Units of Measure

OrthoView™ displays measurements in Sl units legally acceptable within the European
Union. Where applicable, the user may select alternative non-standard units where
medical convention, for instance, uses such units.

Explanations of functions and controls

Explanation of the function of each control and display.

Each control and display has associated context sensitive help. Lay the pointer over the
control and an explanatory pop-up box will appear. Refer also to the system SmartHelp
for an explanation of OrthoView™ and the sequence of operation.

Request a Printed User Guide (Instructions for Use)

To receive a printed copy of this user guide, please fill out this form:
http://www.orthoview.net/UserGuides/index en.jsp?appld=&orderReference=&udi

You will need your OrthoView OR number and version. Alternatively, you can launch
OrthoView and select <Request printed User Guide> on the Help menu, which will
automatically fill in your OR number and version on the form.
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Special Instructions

Special Operating Instructions

To prevent misuse or abuse by others, protect your user access codes and do not
disclose them to others. Always log off the system or otherwise lock the use of the work-
station when you are away from it.

Technicians, particularly Administrators, must not attempt to alter code or settings that
would be entered by Clinical Users. They must not use the software as an Operator
when logged on as an Administrator in case this overwrites any Clinical User data or
settings.

Operators must not attempt to provide extremes of data input for instance by pressing
keys continuously or providing intentionally incorrect input, toggling IT equipment power
etc.

Persons operating and installing OrthoView must not have sensory/physical impairment
to a degree that the IT equipment cannot be operated effectively and warnings and
cautions cannot be discerned or acted upon.

Operators must verify that the displayed user details are those for which the plan is
required. Stored plans must be controlled (reliably stored, backed up) by the operator or
technician. This is particularly important where plans are saved to disk rather than direct
to a PACS system.

Warnings

Any diagrams or pictures used in the Help and in accompanying documents associated
with the product and in promotional literature are for illustrative purposes only and any
readings, displays or indications may not be the same as those obtained during actual
use.

Any user settable parameters in the software or on the PC must be checked and
deemed acceptable by the operator before use.

The device is not to be used for mammography.
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Declaration of Conformity
EC Declaration of Conformity to Medical Devices Directive 93/42/EEC

EC Declaration of Conformity

OrthoView™ - Class lla Medical Device

Manufacturer:

Meridian Technique Ltd

2 Venture Road
Southampton Science Park
Southampton

Hampshire

SO16 7NP

Telephone: +44 (0) 2380 762 500
Fax: +44 (0) 2380 762 550

I, the undersigned, hereby declare that the Class lla medical device specified
below to which this declaration relates; is in conformity with the applicable
provisions of Council Directive 83/42/EEC of 14 June 1993 concerming
medical devices.

i Version Number Product Description

| Software version 5.3 onwards OrthoView™

This declaration is made under Annex ||, section 3 of Council Directive
93/42/EEC concerning medical devices, under the supervision of Notified
Body ID no.: 0843, UL International (UK) Limited, in accordance with
certificate number EC 1':E'rti’ﬁcate no. 564, 150630.

Signed: ....... T M i s Date; B May 2018

Siddhartha Kdnti
Managing Difettor
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